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World Editor
1. Introduction
The World Editor software lets you create new road maps for Foerst F12 driving simulators in a
very easy and comfortable way. The worlds are constructed by arranging prefabricated tiles. Like
in a jigsaw puzzle, you can construct new virtual worlds by reasonably placing tiles. The tile library
offers various straights, curves, junctions and roundabouts in typical environments like in a city, on a
rural road or on a motorway. Most tiles have a virtual size of 100 by 100 meters, but bigger tiles are
also available.
After selecting a tile, it can be rotated and placed. Already placed tiles can be moved or copied.
It is also feasible to group a number of tiles and copy, move and rotate the complete group. By using
this function e.g. a complete part of a city can be duplicated with only a few mouse clicks.
The results can be examined in a separate 3D view. Here the user can move his camera either
freely or ground-bound (as seen from inside a car) and examine in detail if his new virtual world is
as expected. The screen can be split up, so that the user can see the 3D view and the 2D construction
view at the same time.
Many tiles come along with already prepared standard traffic sign configurations. For example,
you can decide if your junction should have traffic lights, if there should be a priority road or if there
should be no traffic signs at all. Also other signs like speed limits can be set up.
For performance reasons it is important, that the simulator only has to show a limited amount of
tiles at all times. The default settings for sight distances are rather restrictive, and plopping artifacts
will very likely be visible. These artifacts can most easily be detected using 3D view. With just a few
mouse clicks, you can change the set of tiles which are visible from any given tile.
After you have placed all tiles and traffic signs and have adjusted sight distances, the results can
be imported into the simulator software very easily. After starting the simulator, a driver can choose
the weather conditions, the traffic density and then start his first ride in your shiny new world.

1.1. World Editor Projects
A World Editor Project consists of the set of Worlds available in a particular installation of the F12
Driving Simulator software (hereafter called F12 instance), together with the set of Tiles available in
that particular installation. Usually, you will work on the worlds available in the F12 instance that is
installed together with the World Editor. That way, this F12 instance can be used to immediately test
your new worlds. At certain times, you will want to export this project to the F12 instances on one or
more simulator computers. Although the project export process essentially consists of copying XML
files into the correct folders of the target instance, the World Editor offers a function to perform the
copy operation. In addition, this function first performs a compatibility check between the source and
target F12 instances. Details may be found in section 8.
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2. User Interface Elements

The above screenshot shows the most important element of the user interface.
1: Menu Bar. The menu contains entries for global operations and settings. The File menu lets
you load, save and close projects. As most operations on the worlds are done by drag and drop
operations or by using context menus, the global Edit menu mainly gives access to some global
settings. The View menu controls visibility of other user interface elements and the Help menu
contains the inevitable About box.
2: Main Toolbar. The main toolbar contains buttons for the most frequently needed global operations: Creating new worlds, opening and saving projects and undo/redo. Most operations in the
World Editor can be undone or redone again. The Buttons provide access to the (unlimited) operation stack. You can also undo and redo single operations using the usual keyboard shortcuts
hC TRL +Zi for undo and hC TRL +Yi for redo.
3: Status Bar. Most of the time, you can safely ignore the status bar at the bottom of the main
window. Only when something does not work as you expect, it may be worthwile to have a
look there, as it may provide a clue about why something was not possible.
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4: Project Tree. The project tree lists all currently available worlds in the project1 . You can open a
2D view of a world by double-clicking on the corresponding entry. Additional 2D views can be
created using the context menu opened when you right-click on an item. The worlds provided
with a fresh F12 installation are opened read-only2 , which is indicated by a red header text in
the 2D window. You connot modify these worlds, but you can use them as copy sources by
selecting parts of them and dragging them into a new world.
The project tree also lists all the available tiles and you can use this list as a drag source for
constructing new worlds. In general though, you will use the Tile Toolbox (5) for this purpose,
because it allows easier identification of tiles using thumbnail images.
5: Tile Toolbox. The tile toolbox is the primary source of tiles to construct new worlds. In contrast
to the screenshot, it is by default located in a second tab in the same pane as the project tree.
Using the View menu, you can open several toolboxes. By dragging the tabs from the initial
pane, you can put them into distinct panes, which you can then dock at a place of your own
choice, e.g. as shown in the screenshot.
The toolbox shows the available tiles as thumbnails, the size of which can be adjusted using the
menu View → Settings. The drop-down box at the top of the toolbox lets you select a category
filter for displaying only a subset of the available tiles. In addition to the predefined categories,
you can also create categories of your own. More on this can be found in section 4 of this
document.
6: Property Pane. The property pane shows tabbed property pages for the object(s) you are currently working with. Some properties are purely informational and others can be changed.
Examples for the latter are standard sign configurations or tile lookup names, which are important if you plan to write scenarios using your worlds in conjuction with the Programming Tool
script language. Usually, the property pane will show just what you expect: When changing
the current selection in a 2D view of a world, the set of displayed property pages also changes.
If the object of your interest should eventually not be contained in the property pane, try rightclicking it and select Properties.
7: 2D Layout Window By double-clicking the corresponding entry in the project tree (4), you
open a 2D view of a world. This is where you will arrange the tiles forming your world and
where you will also adjust sight distances. Details about layout windows may be found in
section 5. Apart from selecting tiles to edit their properties in the properties pane, the most
important operations are:
• Rearranging tiles: You can rearrange or duplicate tiles by dragging them around with the
mouse: Press the left mouse button, drag to the target location, then drop them by releasing
the mouse button. Using the hC TRLi key while dragging, you can switch between moving
(the default for editable source worlds) and copying. Pressing the right mouse button in
addition to the left rotates the tile(s) being moved by 90°. You can even drag tiles between
different 2D layout windows, independent of the world they are showing. This allows you
to transfer tiles between worlds or to move tiles from one end of a large world to the other
(using a second layout window for the same world).
• Placing new tiles: Just drag tiles from a tile toolbox or the project tree. For obvious
reasons, this is always a copy operation.
1

Some world available in the F12 simulation software are not listed here, because they use legacy technology from
former software versions. These can neither be edited using the World Editor nor are they usable as copy sources for
constructing new worlds.
2
These worlds are used by the simulator’s driving programs, which rely on details of the worlds. Hence, you could
easily break the provided driving programs by modifying the default worlds.
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• Deleting tiles: Select the tile(s) and press hD ELETEi.
• Editing sight distances: Right-click on the tile of interest and select Edit sight distance.
You can then select all the other tiles that need to be visible while the driver is on the
selected tile using single mouse clicks. Leave this mode by pressing the button appearing
at the upper left corner of the layout window3 . Note, that dragging tiles is disabled while
the sight distances mode is activated.
8: 3D Preview Window. By right-clicking on a tile in the 2D layout window, you can open a
context menu. One of the options presented there is 3D preview here. Using this option opens
a 3D view with the camera located at the selected position looking north (upwards in the 2D
window). Details on available 3D options and navigating the camera can be found in section
6. In the screenshot example, the 3D preview window has been moved to the right half of the
document screen space. You can achieve this by dragging the tab at the top of the document
window to one of the borders of the document space. If you have more than one monitor, it
may also be useful to drag the document tab outside the frame. It will then float in a document
frame of its own4 , which you can freely place on the desktop – in particular on a second screen.
If you have more than one frame open, you can also drag document tabs from one frame to the
other.

3. Quick Tour – Example Workflow
This section shows you how to construct a simple world. The steps described here are neither the
only way to do things nor are they the most efficient way to go about constructing worlds, but should
make you acquainted with the user interface. It propably is a good idea to first do things exactly as
described, and later experiment a bit in order to find the work flow best suiting you.
When you first start the World editor, you will see a rather empty frame. Before you can do
anything else, you must open a project. Either click on the corresponding icon in the main toolbar
or select File → Open Project in the menu. Navigate to the project’s P LATES . XML and open it. In a
default installation you will find it as C:\P KW \W ORLDS \P LATES . XML. The project tree will appear
docked to the left window edge and the plates toolbox behind it in a tab with header All Tiles. Now
click on the World icon in the main toolbar. A dialog will pop up asking you to specify a name for
your new world.

Enter something and press OK. The document area will now be filled with an (empty) 2D layout view
of the new world. Activate the toolbox by clicking on the tab header reading All Tiles. In this example,
we want to create a small urban world. Select Urban Tiles in the drop-down control at the top of the
toolbox window. Your screen should now look similar to the following screenshot:
3

Refer to section 5.2 for details about adjusting sight distances. In particular, there are more efficient ways than
described here to adjust sight distances for more than just one tile.
4
Document frames cannot be docked to the main frame. Instead of docking, drag the conatained tab(s) back to the
main frame.
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We could now directly start dragging tiles from the toolbox to the layout window, but for the sake
of this walkthrough we first want to reduce the large amount of tiles in the Urban Tiles category to
something more manageable. We want to construct a simple eight using only 90°curves, straight road
pieces and a four-way junction and would like to create a new category holding only the required tiles.
Click on the tiles in the toolbox to view their properties in the property pane, then select the tiles you
want to use and right-click to get a context menu. Select Add to new Category.
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Type a name for your new category and press OK, then activate the new category by selecting it in the
header drop-down box of the toolbox. You can remove tiles from a custom category by selecting them
and pressing hD ELETEi. You can add additional tiles using the context menu while showing another
category or by dragging tiles into the toolbox – either from a world or from another tile toolbox5 .
Drag the crossroads tile into the layout window, then complete one half of the eight by leftdragging straights and curves into the world, using the right mouse button to rotate as necessary. You
can move the visible section of the construction plane using the middle mouse button and zoom in
and out using the mouse wheel6 .
Your workspace should now look similar to the following screenshot.

Using the left mouse button, drag a frame across all the plates in the layout window in order to select
them all. Then click on the crossroads tile while holding the hS HIFTi key. This toggles the selection
state of the clicked tile, leaving you with everything selected but the crossroads tile. Now complete
the eight by dragging and rotating the entire selection while holding the hC TRLi key (the hC TRLi key
must be pressed while releasing the left mouse button, not necessarily while pressing it to start the
drag process). Now, we have a complete road network:
5

View → Additional Tile Toolbox, then drag the tab out of the pane to obtain a freely floating toolbox. The floating
toolbox can then be docked wherever you like.
6
If you don’t have a middle mouse button or a mouse wheel, you can use hA LTi together with left and right mouse
button to achieve the same effect.
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Right-click on the centre of the crossroads tile and select 3D Preview here. Try navigating the camera.
Walk the ground using the arrow keys (hS HIFTi for more speed) of freely position the camera using
the mouse: While holding the hA LTi key, use the middle mouse button to translate the camera, the
left to rotate the camera and the right button to rotate around the clicked point in the world. The Home
icon in the 3D toolbar always brings you back to where you started.
You will notice, that something is not right yet: As you move on, new parts of the world keep
plopping into view or simply vanish while you move backwards. Before we adjust the sight distances,
we slightly tweak our workspace to better suit our needs: First free some screen real estate by closing
the pane containing project tree and tile toolbox (click on the × at its top right corner). You can get
back the tree and toolbox using the View menu. Now left-click on the 3D view’s tab header and drag
it towards the right border, until a hint rectangle tells you releasing will reposition the 3D view in the
right half of the document area. Release the mouse button to obtain a split view with the 2D window
on the left and the 3D window on the right7 .
7

This layout is just one possibility of arranging windows. Choose the one you like best.
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In the 2D view, right-click the crossroads tile and select Edit sight distance. The view will change to
sight distances mode:

The hightlight on the crossroads tile marks the tile, the sight distance of which is being edited. Light
tiles are visible from there and dark tiles are not. You can change the visibility state of most tiles by
single-clicking them with the left mouse button. The visibility state of tiles with a small lock on them
cannot be changed – they are automatically visible. Click on all the tiles which should be visible from
the junction, up to and including the final 90°curves. You will observe, that the 3D view changes as
you click on the tiles it is looking at. If you make a tile visible, which is not connected to the central
visibility range, you will notice a small needle pin icon on it. Right now, you can safely ignore this. It
is just a hint, that this tile is treated differently concerning relocation. If you later decide to move part
8
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of the world, tiles marked in this way will stay visible, while the central viewing range moves with a
tile.
After having adjusted the sight distance for the crossroads tile, continue adjusting sight distances
for all other tiles. You could do so by leaving sight distances mode using the button at the top left
corner of the layout window and right-clicking on the next tile, but it is faster to just double-click
the next tile to edit while still in sight distances mode. Double-clicking the currently edited tile is an
alternative way to leave sight distances mode.
As you proceed, you will notice, that fewer and fewer tiles have to be adjusted. This is due to
reflexivity – whenever you make a tile visible, the currently edited tile will be visible from that tile.
This feature can be turned off (Edit → Preferences → Reflexive SightDistances), but you are strongly
advised not to do so. Not only will you almost double your future work, but a need to turn off this
feature almost always indicates a serious design flaw of your world. Think twice.
For simple worlds like this, the above process is sufficient to produce a plopping-free world.
Sometimes though, plopping artifacts can not be so easily anticipated from top-down view. In our example, place some tiles of type Urban Block of Buildings (category Urban Tiles) around the 90°curves
in our world. It now looks like this:

Set the focus to 3D view and walk around. You will now notice massive plopping behind the curves!
To help you detect such problematic places in your world (even before you pass the point of plopping),
there is an additional viewing option in 3D mode. Turn off respecting sight distances using the button
in the 3D view’s toolbar. Then, turn on marking of invisible tiles using the button . Already
from very far away, the problematic tiles will draw your attention by their strong purple colour.
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One way to rectify the problem is right-clicking the purple tile in the 3D view and selecting Clicked
plate visible from here in the context menu. In our example though, it is more efficient to exploit sight
distance reflexivity and edit the sight distance of the problematic Urban Block of Buildings tile in the
2D layout window.
Warning: You might be tempted to walk through the world and eliminate all purple spots by
right-clicking them and making them visible. This is not a good idea. From the exact same position
as in the previous screenshot, turning right in the 3D view produces the following view:

This seems to be a very prominent plopping candidate, but in fact will never plop - the purple tiles
belong to the upper right part of the street eight and will only become visible after having passed the
crossroads. Making them visible will not reduce plopping, but will only negatively impact the frame
10
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rate. Tuning visibilities often means finding a good compromise between reduced plopping and bad
framerates.
After having adjusted all visibilities, we will finish our world by placing traffic lights on the central
crossroads tile. In the 2D layout window, zoom in on the croassroads tile and select it by left-clicking.

In the properties pane under Environment, you find the options for this tile. For this particular tile,
there are five options - one for right of way and four positional options. The position numbers of the
latter correspond to the small numbers now visible in the 2D layout window. In our example, we leave
the positional sign options at Nothing, but you can try and observe, how the 3D view immediately
reflects your choices. For our purposes, we simply switch Right of Way to Traffic Lights. Yes, it is
that simple!
Your new world is now ready for writing scenarios using it in conjunction with the Programming
Tool8 . As for now, we want to avoid writing a scenario, but use the the automatic free driving scenario.
To this end, we still have to define where the ride will start and – optionally – where it will end9 . In
the example at hand, we could select Start Plate for the bus stop plate north of the crossroads and
Finish Plate for one of the straight road tiles. Have a look at section 9 to see which tiles offer these
options.
Finally, quit the World Editor application. Answer Yes when asked whether you want to save the
current project. Start up the F12 software (Start → Foerst → F12 ), locate Dynamic Worlds in the
menu10 and start out for your first ride in the new world.
8

Provided that you have a licence for the Programming Tool, use World_FindWorldByName to obtain the world id for
your new world and then write your scenario as you would do using a built-in world.
9
If you don’t select a start tile, automatic free driving will nevertheless work, but the start point depends on the order
of construction and might be in the middle of a junction. If you define a finish tile, the driver will be guided there by a
route guidance system.
10
If your menu does not contain the program Dynamic Worlds, you may have to activate it using Start → Foerst →
Configure. Skip to the Additional Settings page and select Dynamic Worlds.
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4. The Tile Toolbox

The tile toolbox is the place where you quickly find the tiles to insert into a world. All available tiles
are shown with their names and a small picture (5) showing the tile from in a top view perspective.
The size of this picture can be adjusted using the menu View → Settings → Toolbox Icon Size. If
you need more information, a description string is shown while you hover the mouse pointer over a
tile. Even more information is displayed in the property pane (c.f. section 7) when you click on a tile.
Tiles are inserted into a world by dragging them with the mouse from the toolbox into a world’s 2D
layout window.
The rest of this section describes, how you can place one or more toolbox(es) on your workspace
and how you can organize the available tiles to find them more quickly.

4.1. Showing and Placing Toolboxes
Tile toolboxes are always shown as tabbed documents (2) inside panes (1). When you first open a
project, a tile toolbox will be shown as a tab inside a pane docked to the left window border, together
with the project tree. More tile toolboxes can be shown using the menu View → Additional Tile
Toolbox.
A pane can be either docked to the main window or freely floating. You can close a pane by
clicking the small × at the right end of its caption (1). When you drag a docked pane’s caption, it will
begin to float in a frame of its own. When dragging a floating pane’s caption to a place suitable for
docking (the mouse pointer must be at a position suitable for docking, not the entire frame), a bluish
hint is shown and if you release the mouse button, the pane will be docked at the specified position.
A docked pane can be resized using the grip (4) at its side.
If there is more than one tab inside a pane, each individual tab can be closed using a small × in its
tab header (2). When you drag a tab header out of its pane, it will be transferred into a new floating
pane of its own. You can move tabbed documents between panes by dragging their tab headers (2).
When you drag the last tab out of a pane, the pane will be closed.
12
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4.2. Using Tile Categories
When you first open a tile toolbox, it will show the All Tiles category, which is reflected by the dropdown box (3) above it and also by its tab header (2). This means, that all available tiles, except for
some special tiles not meant for constructing new worlds, are shown in its content area. This is good
for getting an overview about the available tiles, but the sheer amount of tiles makes it hard to quickly
locate the tile you are looking for. You can restrict the set of displayed tiles by clicking on the dropdown box (3) and selecting another category. When you do so, your selection is reflected in both the
drop-down box and the tab header and only tiles belonging to the selected category are shown. In a
fresh project, the categories
• All Tiles
• Highway Tiles
• Rural Tiles
• Urban Tiles
can be chosen11 , but you can also define new custom categories, which comprise exactly the tiles
you want to see grouped together. All existing categories and their members are not only shown in
the tile toolbox(es), but are also listed in the project tree under Available Tiles.

4.3. Managing Custom Categories
There are two ways to create a new category. The first one was already described in section 3:
1. In the toolbox window, select one or more tiles as initial contents for the new category.
2. Right-click on one of them to open a context menu.
3. If it is your first custom category, select Add to new Category. If it is not, select Add to Category
→ New Category.
4. A dialog is shown, where you can specify a name for the new custom category.
The other way to create a new category is by clicking the header drop-down box. Instead of selecting
one of the existing categories, select hNew Category. . . i. A dialog appears:

Enter a name for the new custom category. By default, the new category will initially be empty.
Optionally, you can choose to create it as a copy of another category using the the drop-down box
located beneath the name edit field. Press OK to create the new category.
Before we discuss how to modify the contents of a custom category, here is how you can rename a
custom category or eventually get rid of it again: When there are any custom categories defined, you
can click on the header drop-down box (3) and select hEdit Categories. . . i. A dialog appears:
11

There might also be a category Legacy Tiles, the members of which you should not use for constructing new worlds.
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The list on the left side contains all existing categories. Custom categories are displayed in black,
while predefined categories are in red and cannot be modified. When you select a custom category,
the two buttons on the right side become available. Pressing Remove does just that - it removes the
custom category12 . Pressing Rename sets the focus to the category label in the list window to the left.
You can type the new name and press hE NTERi to confirm the new name. Press hE SCAPEi to cancel
the operation.

4.4. Modifying a Custom Category
If you want to remove a tile from a custom category, first show the custom category in a toolbox
window by selecting it with the drop-down box (3). Then, select the tile(s) to be removed and press
hD ELETEi. This has no effect, if the displayed category is not a custom category. If you want to add
one or more tiles to a custom category, there are two ways to do so:
1. Show another category in a tile toolbox and select one or more tiles. Right-click on one of them
to show a context menu. Select Add to Category → NN, where NN is the name of your target
custom category.
2. Show the target custom category in a tile toolbox. You can now drag tiles into the toolbox using
the mouse. Possible sources for dragging are another toolbox, the project tree or any world’s
2D layout window.

5. The 2D Layout Window
When you double-click a world item in the project tree, a 2D layout view of this world is opened. If
it was already opened, the old window is put to front. If you want to open a second (or third) layout
view of a world, right-click the world item in the project tree and select Open in new tab. Having
more than one layout view of a world open is particularly useful for large worlds, when you might
want to copy or move tiles from one end of the world to another.
The layout window shows two-dimensional representations of the world’s tiles on an infinite
plane. The empty plane is painted in black with grey lines showing the 100m × 100m grid, to which
all tiles are aligned. You can move the visible section using the middle mouse button and zoom in
and out using the mouse wheel. Alternatively, use the hA LTi key together with the left mouse button
to move and hA LTi together with the right mouse button to zoom.
As a general rule, you use the left mouse button (without the hA LTi key) to modify the world and
the right mouse button to open context menus. When right-clicking on a tile, the context menu will
12

Just like most other operations, renaming or removing a category is part of the action history. If you accidentally
remove a category you still need, close the dialog and press hC TRL +Zi to undo the operation.
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always contain an entry 3D Preview here, which you can use to open a 3D view of the world (c.f.
section 6). This can be useful while composing the world (see visual changes while you are editing)
and is invaluable while adjusting sight distances (detect plopping artifacts).

5.1. Arranging Tiles
When you first open a 2D layout view of a world, it is in arrangement mode, allowing you to add,
move and delete tiles. Selected tiles are shown with a bluish highlight and frame on them. The
window has a second mode for adjusting view distances, which we will discuss in section 5.2. You
recognize this second mode by yellowish selection highlights and a small button Exit Sight Distances
Mode in the upper left corner of the window – press this button to leave view distance mode and return
to arrangement mode.
5.1.1. Selecting Tiles
Each world has a current selection, which is synchronized across different views of the same world.
You select tiles by left-clicking them. Clicking on an empty spot of the layout plane removes the
current selection. You can select multiple tiles using a selection frame: Left-click on an empty spot
of the world and start dragging the mouse to see a frame spanning from the initial click position.
When you release the mouse button, all tiles under the frame will be selected. Left-clicking a single
tile while holding the hS HIFTi key toggles their selection state, i.e. adds them to the selection if they
were previously unselected or removes them if they were selected. Dragging a selection frame while
holding the hS HIFTi key always adds the framed tiles to the selection. In arrangement mode, each
tile is either selected or unselected. This means, that tiles larger than the standard 100m × 100m will
always be completely selected or completely unselected. Whenever you change the current selection,
the change will be reflected in the properties pane (c.f. section 7).
5.1.2. Deleting Tiles
Removing tiles from a world is simple: Select the tile(s) you want to remove and press hD ELETEi.
Like all other modifications of a world, deletion of tiles can be undone: Press hC TRL +Zi or use the
main toolbar or the main menu.
5.1.3. Adding Tiles
You add tiles to a world by dragging them from a tile toolbox window (c.f. section 4) or the project
tree. Locate the tile to be added either in the toolbox window or in the project tree under Available
Tiles. Press the left mouse button on it and drag it into the layout window. At the place where you
want the new tile to be added, release the mouse button. As soon as the mouse enters the layout
window, the new tile will be shown as it would appear if you released the mouse button. If it cannot
be dropped at a particular location, the dragged image will change to a red wireframe. While you
drag the tile, you can rotate it by pressing the right mouse button in addition to the left. Each right
mouse button click rotates the floating tile by 90°clockwise. Whenever a new tile is added to a world,
it is given a new unique lookup name, which is auto-generated and usually is quite ugly. If you only
plan to use your worlds as free driving worlds, you can ignore these names, as they will not appear
anywhere in the user interface of the simulator. If you plan to write scenarios using the Programming
Tool software, you will use these names to identify tiles from the scripting language. You might then
want to change the lookup name to something more readable in the tile’s property page.
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5.1.4. Moving and Copying Tiles
You can move the current selection by pressing the left mouse button on it and dragging it to its new
location. During the drag operation, you are given the same visual feedback as while adding tiles and
you can rotate the dragged set of tiles using the right mouse button. When you release the mouse
button at a suitable place, the move operation is completed. This target place might not only be in
the same layout window where you started dragging, but it can also be in a different layout window,
either showing the same or a different world. Rotating tiles is just a move operation: You can press
the left mouse button and then press the right mouse button even without having dragged the selection
at all.
While you are dragging tiles, you can press and hold the hC TRLi key to change the move operation
to a copy operation. When you do so, the dragged tile(s) will reappear at their original position(s). If
you release the left mouse button while the hC TRLi key is pressed, the tiles are not moved, but copies
are inserted at the selected position. Because the dragged tiles are still in the world, the possible target
locations for copy operations are obviously more restricted than for move operations.
When moving and copying tiles, as many properties of the dragged tiles are preserved as possible.
New lookup names are generated for copy operations or move operations to new worlds, if the latter
would otherwise produce name clashes. If you already adjusted sight distances (c.f. section 5.2), the
program tries to be smart about what should be visible after moving. Concerning relations between
tiles simulataneously moved, it does a good job, but relations between moved and stationary tiles will
likely be disturbed. The lesson to learn from this is: Always adjust sight distances after you have
composed your worlds. If this is not possible (e.g. because you are modifying an old world), review
the sight distances in the affected parts of the world.
5.1.5. Teleport Links (Advanced)
When you right-drag tiles instead of the usual left-dragging, you will be shown a context menu at the
target location. This context menu allows you, in addition to the usual Copy and Move operations, to
Link the tile(s). This will place visually identical copies of the target tile(s) in the world (in particular
having identical option choices) which function as teleport points. This means, that in the simulation
the driver will be teleported from the newly created link tile to the drag source. The new tile(s) are
decorated with a small icon and the drag source tile(s) with a small .
Linked tiles allow the creation of infinite worlds without the need to insert curves. Making this
work as you would expect is hard, though. The complete environment of the linked plates must be
visually identical in order that the teleport will not be visible. In addition, all tiles visible from the
teleport point with roads on them must also be members of a link pair in order that other vehicles will
not simply vanish in the simulation or appear out of thin air. The rule to follow is: Seen from the tile
immediately before the jump source, this and all visible tiles to the rear must be jump targets from just
before the teleport destination. All visible tiles after the teleport tile (which the driver will never reach
because he is being teleported) must also be teleport sources for tiles behind the teleport destination.
Visibility distances must be set independently, but consistently for link targets and destinations. A
very simple example for correct linking is shown below:
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5.2. Setting Sight Distances
Using the sight distance mode of the layout window, you can control, which tiles can “see” each other.
You start editing sight distances by right-clicking a tile in arrangement mode and selecting Edit sight
distance. The visual appearance of the layout window changes to reflect the new edit mode.

The selection granularity in this mode is finer than in arrangement mode – tiles larger than the usual
100m × 100m can be split into subtiles, which have independent sight distances. In the screenshot
above, the sight distance of the left half of the central double bend tile is being edited. The edited
subtile is always marked with a yellowish highlight and frame. Other tiles are shown normally if
they are visible and darkened, if they are not. The small lock icons mark subtiles, which are
automatically visible, either because they are direct neighbors of the edited subtile or due to internal
technical reasons. Subtiles marked with a small needle pin are outside of a connected view area
around the edited subtile. They behave differently when the edited subtile is moved later on: For such
subtiles the program assumes that they contain some widely visible landmark and they stay visible
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independently of a possible relocation of the edited tile.
Editing visibilities is simple: Just single-click a subtile to toggle its visibility. Note, that the
selection granularity also is the subtile, so clicking a 100m × 100m section might also affect the
visibility of neighboring sections. If you want to edit the visibility distances of another subtile, just
double-click it. Double-clicking the currently edited subtile leaves visibility distance mode. Further
methods to alter visibility distances are provided by the 3D preview window, c.f. sections 3 and 6.

6. The 3D Preview Window

Using the context menu in a world’s 2D layout window allows to open a 3D view on that world.
There are two ways to move the camera position. Use the arrow keys to move on the ground and
get a perspective similar to that seen in a simulator. Press hS HIFTi together with h↑i or h↓i for more
speed. You can also freely position the camera using the mouse: While holding the hA LTi key, use
the middle mouse button to move the camera left, right, up and down. Use the left mouse button to
rotate around the camera position and the right button to rotate around the clicked point in the world.
After you have freely positioned the camera, pressing one of the arrow keys brings you back to the
ground.
Each 3D preview window has its own toolbar. The meaning of the buttons is as follows:
Button Meaning
This is a toggle button. When it is activated (the default), the 3D preview
window respects tile visibilities, i.e. tiles will be visible whenever they
would be in a simulator. This is the best way to judge plopping artifacts.
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Button Meaning
This is also a toggle button. It is only available, when visibilities are
not respected. When it is activated, normally invisible tiles are painted
in an eye-catching purple color. This can also be used to detect visibility problems. See section 3 for an example of its application and an
explanation, why this tool is not the universal saviour.
Another toggle button. Normally, a world’s current selection is not reflected in a 3D preview window. When this button is activated, parts
of the current selection are also given a bluish shimmer. This can help
your imagination when comparing the layout view with the 3D view.
Yet another toggle button. If you use the advanced linking functionality
(c.f. section 5.1.5), this button lets you decide whether you want to test
teleporting or want to view the world as you build it.
Press this button to reset the camera to its initial position.
–

Press one of these buttons while holding the hS HIFTi key to store the
current camera position. Then, press it without holding hS HIFTi to return to that position.
By default, the preview camera has a horizontal aperture of 45°. Using
this control, you can modify this. You can e.g. use this functionality
in order to see a wider angle when scanning for plopping artifacts. Be
warned, though: Using values largely different from the true viewing
angle leads to a strongly distorted space perception. This might have an
impact on your well-being.

Some of the settings available in the 3D toolbar can also be controlled using the context menu popping
up when you right-click in the 3D view. In addition, the menu entry Edit visibility distances from here
allows you to switch to a 2D layout window and immediately edit the sight distance of the subtile the
camera is currently on (not the subtile you have clicked on!). When the purple tile option is activated,
you may in addition be given the opportunity to control the clicked subtile’s visibility as seen from
the current camera position – check or uncheck the menu entry Clicked tile visible from here.

7. Property Pages
The set of property pages shown in the properties pane automatically changes when you click on
objects which support properties. In addition, you can explicitly request a property page by rightclicking on an item and selecting Properties. This section explains the contents of the most important
types of property pages.
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7.1. Simple Tile Properties

Most available tiles are simple tiles, i.e. they have no substructure. The property page for such a tile
is similar to the above screenshot. The small 3D representation of the tile at the top of the property
page might be missing immediately after the program starts and only become visible after the 3D
subsystem has started.
While most properties are read-only, some can be edited in the property page. The Lookup is
used from the Programming Tool scripting language and can be changed to something more readable
than automatically created by the software. Note, that the software always ensures uniqueness of
lookup names. If you enter a name which would not be unique among the tiles in a world, a suffix is
automatically appended. The position and rotation of a tile are much easier adjusted using the mouse
in the 2D layout window, but changing tile placement using numbers is possible.
The most important part of a simple tile’s property page is the Environment section. Here, you
can select options for the tile. The available options depend on the tile type and are listed in section
9. Numbered positions in the option labels refer to certain positions on the tile. As soon as you set
the focus on an option by clicking it with the mouse, small numbers are displayed on the tile in the
2D layout window.
A simple tile in the toolbox is only a template, not an instance. Hence, only the information listed
under Plate Type is shown.

20

W ORLD E DITOR

7. P ROPERTY PAGES

7.2. Composite Tile Properties

Some tiles are larger than 100m × 100m and have an inner substructure, which you already encountered when setting view distances (section 5.2). Each part of the internal substructure has its own
lookup name, whence the single Lookup property for simple tiles is replaced by multiple lookups.
Setting environment options for a composite tile works almost identical to simple tiles. The only
difference is, that more than four positions might be referred to and are shown in the 2D layout
window.
A composite tile in the toolbox is only a template, not an instance. Hence, no information related
to a particular instance is shown.

7.3. Selection Properties

A special case among the different types of property pages is the Selection property page. In order not
to clutter the property pane, it is displayed instead of the many property pages corresponding to the
objects in a larger selection. It shows only short comprehensions of the selected objects’ properties.
If you want the complete information about one of the selected objects, either select this object only
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(the properties pane will change) or select the object of interest in the Selection property page. If you
click the small button with the dots on it, the property page for that object will be shown.

8. Exporting to a Simulator
Assume you have created some very beautiful worlds and now want to install them on a simulator.
Provided the versions of the F12 instances on your Computer running the World Editor and on the
simulator are exactly identical, the simplest way to do so would be to copy the contents of the Worlds
subfolder of the F12 installation folder over to the simulator.
Warning: If your simulator is driven by multiple computers, you must keep the Worlds folders on
them in sync! This is necessary whether you use the copy method or the export method described
below.
In order to protect you from copying incompatible world files to a simulator or erase additional
worlds that may be already installed on the simulator, the World Editor software has an Export function. As a prerequisite, you must share the F12 installation folder on the simulator computer(s) in the
network, so that the computer running the World editor can access these folders as network shares
with write access.
When you now select File → Export in the menu, you are asked for the destination folder. Navigate to the Worlds subfolder of the network share on your simulation computer and select Plates.xml.
The World Editor will now check your project for compatibility with the destination installation. If
any incompatibilities are detected, you will be warned. Even in that case, you can proceed to export
as many of your worlds as possible (i.e. all worlds not using features which are not present in the
destination installation). If additional worlds are detected in the destination folder, you can decide
whether to delete them or not.
At the end of a successful export process, you are given the opportunity to open the target folder
as new working project. Choosing Yes here is only sensible, if the target is not a simulator, but another
F12 instance, to which you want to port your work.
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9. Available Tiles
This section lists all available tiles with a short description of their properties.

9.1. Curved Rural Road

Name:
Curved Rural Road
Description:
Curved rural road with one lane (4m) per direction.
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9.2. Highway 2x2 Double Bend (A)

Name:
Highway 2x2 Double Bend (A)
Description:
Curved highway road with 2 lanes (4m) per direction. Over a range of approx. 200m, the
road first bends left, then right again.
Options:
Position 4: Nothing, Speed Limit 80, Speed Limit 100, Speed Limit 120, End Of All Prohibitions
Position 10: Nothing, Speed Limit 80, Speed Limit 100, Speed Limit 120, End Of All Prohibitions
Remarks:
Use this tile to reduce the number of simultaneously visible tiles.
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9.3. Highway 2x2 Double Bend (B)

Name:
Highway 2x2 Double Bend (B)
Description:
Curved highway road with 2 lanes (4m) per direction. Over a range of approx. 200m, the
road first bends right, then left again.
Options:
Position 4: Nothing, Speed Limit 80, Speed Limit 100, Speed Limit 120, End Of All Prohibitions
Position 14: Nothing, Speed Limit 80, Speed Limit 100, Speed Limit 120, End Of All Prohibitions
Remarks:
Use this tile to reduce the number of simultaneously visible tiles.
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9.4. Highway 2x2 Double Bend (C)

Name:
Highway 2x2 Double Bend (C)
Description:
Curved highway road with 2 lanes (4m) per direction. Over a range of approx. 400m, the
road first bends left, then right again.
Options:
Position 4: Nothing, Speed Limit 120, End Of All Prohibitions
Position 18: Nothing, Speed Limit 120, End Of All Prohibitions
Remarks:
Use this tile to reduce the number of simultaneously visible tiles.
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9.5. Highway 2x2 Double Bend (D)

Name:
Highway 2x2 Double Bend (D)
Description:
Curved highway road with 2 lanes (4m) per direction. Over a range of approx. 400m, the
road first bends right, then left again.
Options:
Position 4: Nothing, Speed Limit 120, End Of All Prohibitions
Position 30: Nothing, Speed Limit 120, End Of All Prohibitions
Remarks:
Use this tile to reduce the number of simultaneously visible tiles.
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9.6. Highway 2x2 Service Station

Name:
Highway 2x2 Service Station
Description:
700m of straight highway road with two lanes (4m) per direction. On one side of the road,
there is a service station with parking lot.
Options:
Position 4: Nothing, Speed Limit 120, End Of All Prohibitions
Position 54: Nothing, Speed Limit 120, End Of All Prohibitions
Start Plate: No, Yes

9.7. Highway 2x2 Straight

Name:
Highway 2x2 Straight
Description:
1km of straight highway road with two lanes (4m) per direction. A bridge crosses the
highway.
Options:
Position 4: Nothing, Speed Limit 120, End Of All Prohibitions
Position 38: Nothing, Speed Limit 120, End Of All Prohibitions
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9.8. Highway 2x3 Straight

Name:
Highway 2x3 Straight
Description:
1km of straight highway road with three lanes (4m) per direction. A bridge crosses the
highway.
Options:
Position 4: Nothing, Speed Limit 120, End Of All Prohibitions
Position 38: Nothing, Speed Limit 120, End Of All Prohibitions

9.9. Highway Straight Transition 2x3 / 2x2

Name:
Highway Straight Transition 2x3 / 2x2
Description:
1km straight highway road. One end has three lanes (4m) per direction, the other one two
lanes (4m) per direction. A bridge crosses the highway.
Options:
Position 4: Nothing, Speed Limit 120, End Of All Prohibitions
Position 38: Nothing, Speed Limit 120, End Of All Prohibitions
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9.10. Industrial Depot

Name:
Industrial Depot
Description:
An enclosed area with 8m wide gate to be fit to the end of an e.g. 2x 4m wide road. Features
parking spaces and a loading platform. Ideal for manoeuvring.
Options:
Start Plate: No, Yes
End Plate: No, Yes
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9.11. Industrial Depot (200m)

Name:
Industrial Depot (200m)
Description:
An enclosed area with 8m wide gate to be fit to the end of an e.g. 2x 4m wide road. Features
parking spaces, a loading platform and lots of space for e.g. placing swap bodies. Ideal for
manoeuvring.
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9.12. Industrial Depot with warehouse(200m)

Name:
Industrial Depot with warehouse(200m)
Description:
An enclosed area with 8m wide gate to be fit to the end of an e.g. 2x 4m wide road. Features
parking spaces, a warehouse loading platform, and lots of space for e.g. placing swap bodies.
Ideal for forklift truck.
Options:
Start Plate: No, Yes
End Plate: No, Yes
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9.13. Landscape (always visible)

Name:
Landscape (always visible)
Description:
This plate will always be visible! Simple plane for filling gaps in rural worlds.
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9.14. Rural 2x1 90° Curve

Name:
Rural 2x1 90° Curve
Description:
Rural 90° curve with one lane (4m) in each direction.
Options:
Position 2: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
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9.15. Rural 2x1 Bridge with Lake

Name:
Rural 2x1 Bridge with Lake
Description:
Straight bridge with one lane (4m) in each direction crossing a small lake.
Options:
Trees:

No Trees, Trees

Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
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9.16. Rural 2x1 Bus Stop

Name:
Rural 2x1 Bus Stop
Description:
Straight rural road with one lane (4m) in each direction and bus stops in both directions.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Trees:

No Trees, Trees

Start Plate: No, Yes
Busstops:

Busstop, no Busstop, Busstop + Pedestrians
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9.17. Rural 2x1 Crossroads

Name:
Rural 2x1 Crossroads
Description:
Rural 4-way intersection of roads with one lane (4m) in each direction.
Options:
Right of Way: Nothing, Signs "Dangerous Crossing", Traffic Lights, Right of Way (Road),
Right of Way (Junction), Stop
Position 1:

Nothing, Village In, Village Out, End Of All Prohibitions

Position 2:

Nothing, Village In, Village Out, End Of All Prohibitions

Position 3:

Nothing, Village In, Village Out, End Of All Prohibitions

Position 4:

Nothing, Village In, Village Out, End Of All Prohibitions

Trees:

No Trees, Trees
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9.18. Rural 2x1 Double Bend (A)

Name:
Rural 2x1 Double Bend (A)
Description:
Curved rural road with one lane (4m) per direction. Over a range of approx. 200m, the road
first bends left, then right again.
Options:
Position 4: Nothing, Village Out, Speed Limit 70, End Of All Prohibitions
Position 10: Nothing, Village Out, Speed Limit 70, End Of All Prohibitions
Remarks:
Use this tile to reduce the number of simultaneously visible tiles.
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9.19. Rural 2x1 Double Bend (B)

Name:
Rural 2x1 Double Bend (B)
Description:
Curved rural road with one lane (4m) per direction. Over a range of approx. 200m, the road
first bends right, then left again.
Options:
Position 4: Nothing, Village Out, Speed Limit 70, End Of All Prohibitions
Position 14: Nothing, Village Out, Speed Limit 70, End Of All Prohibitions
Remarks:
Use this tile to reduce the number of simultaneously visible tiles.
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9.20. Rural 2x1 Double Bend (C)

Name:
Rural 2x1 Double Bend (C)
Description:
Curved rural road with one lane (4m) per direction. Over a range of approx. 400m, the road
first bends left, then right again.
Options:
Position 4: Nothing, Village Out, Speed Limit 70, End Of All Prohibitions
Position 18: Nothing, Village Out, Speed Limit 70, End Of All Prohibitions
Remarks:
Use this tile to reduce the number of simultaneously visible tiles.
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9.21. Rural 2x1 Double Bend (D)

Name:
Rural 2x1 Double Bend (D)
Description:
Curved rural road with one lane (4m) per direction. Over a range of approx. 400m, the road
first bends right, then left again.
Options:
Position 4: Nothing, Village Out, Speed Limit 70, End Of All Prohibitions
Position 30: Nothing, Village Out, Speed Limit 70, End Of All Prohibitions
Remarks:
Use this tile to reduce the number of simultaneously visible tiles.
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9.22. Rural 2x1 Double Bend with snow remainders when cleared

Name:
Rural 2x1 Double Bend with snow remainders when cleared
Description:
Curved rural road with one lane (4m) per direction. Over a range of approx. 200m, the road
first bends left, then right again. The cleared winter version has snow remainders on the road.
Options:
Position 4: Nothing, Village Out, Speed Limit 70, End Of All Prohibitions
Position 10: Nothing, Village Out, Speed Limit 70, End Of All Prohibitions
Remarks:
This tile can be used to set up special scenarios with localized icy conditions. Do not use for
general purpose worlds.
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9.23. Rural 2x1 Straight (A)

Name:
Rural 2x1 Straight (A)
Description:
Straight rural road with one lane (4m) in each direction.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Trees:

No Trees, Trees
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9.24. Rural 2x1 Straight (B)

Name:
Rural 2x1 Straight (B)
Description:
Straight rural road with one lane (4m) in each direction and small buildings beside the road.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Trees:

No Trees, Trees

9.25. Rural 2x1 Straight through Hollow

Name:
Rural 2x1 Straight through Hollow
Description:
Straight rural road (1km length) with one lane per direction and varying down- and uphill
gradients.
Options:
Position 4: Nothing, Speed Limit 70, End of all prohibitions
Position 38: Nothing, Speed Limit 70, End of all prohibitions
Remarks:
Use this tile for eco-driving worlds.
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9.26. Rural 2x1 T-Junction

Name:
Rural 2x1 T-Junction
Description:
Rural T-junction. All roads have one lane (4m) per direction.
Options:
Right of Way: Nothing, Sign "Yield", Traffic Lights, Right of Way (Junction), Stop
Position 1:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit
70, End Of All Prohibitions

Position 3:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit
70, End Of All Prohibitions

Position 4:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit
70, End Of All Prohibitions

Trees:

No Trees, Trees
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9.27. Rural 2x2 90° Curve

Name:
Rural 2x2 90° Curve
Description:
Rural 90° curve with two lanes (4m) in each direction.
Options:
Position 2: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
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9.28. Rural 2x2 Roundabout

Name:
Rural 2x2 Roundabout
Description:
A rural roundabout with four exits with two lanes (4m) in both directions. The roundabout
itself has two lanes.
Options:
Signs: No Signs, Roundabout Signs
Tree: No Tree, Tree

47

9. AVAILABLE T ILES

W ORLD E DITOR

9.29. Rural 2x2 Straight (A)

Name:
Rural 2x2 Straight (A)
Description:
Straight rural road with two lanes (4m) in each direction and factory buildings beside the
road.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Trees:

No Trees, Trees
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9.30. Rural 2x2 Straight (B)

Name:
Rural 2x2 Straight (B)
Description:
Straight rural road with two lanes (4m) in each direction.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Trees:

No Trees, Trees
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9.31. Rural 2x2 Straight (D)

Name:
Rural 2x2 Straight (D)
Description:
200m straight rural road with two lanes (4m) in each direction and industry buildings on one
side.
Options:
Position 4: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
Speed Limit 100, Speed Limit 120, End Of All Prohibitions
Position 6: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
Speed Limit 100, Speed Limit 120, End Of All Prohibitions
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9.32. Rural 2x2 Straight (E)

Name:
Rural 2x2 Straight (E)
Description:
Straight rural road with two lanes (4m) in each direction.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
Speed Limit 100, Speed Limit 120, End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
Speed Limit 100, Speed Limit 120, End Of All Prohibitions
Trees:

No Trees, Trees
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9.33. Rural 2x2 T-Junction

Name:
Rural 2x2 T-Junction
Description:
Rural T-junction. All roads have two lanes (4m) per direction.
Options:
Right of Way: Nothing, Traffic Lights
Position 1:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit
70, End Of All Prohibitions

Position 3:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit
70, End Of All Prohibitions

Position 4:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit
70, End Of All Prohibitions

Trees:

No Trees, Trees
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9.34. Rural Landscape (Flat Shoreline)

Name:
Rural Landscape (Flat Shoreline)
Description:
Flat straight rural shoreline.

9.35. Rural Landscape (Flat)

Name:
Rural Landscape (Flat)
Description:
Simple plane for filling gaps in rural worlds.
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9.36. Rural Landscape (Hills)

Name:
Rural Landscape (Hills)
Description:
Hilly rural landscape for filling gaps in rural worlds. Blocks sight in all directions.

9.37. Rural Landscape (Hilly Shoreline)

Name:
Rural Landscape (Hilly Shoreline)
Description:
Hilly rural shoreline.
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9.38. Rural Landscape (Tree Palisade)

Name:
Rural Landscape (Tree Palisade)
Description:
Simple plane for filling gaps in rural worlds. A tree palisade blocks sight in one direction.
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9.39. Rural Straight Transition 2x2 / 2x1

Name:
Rural Straight Transition 2x2 / 2x1
Description:
100m straight rural road. One end has one lane (4m) per direction, the other one two lanes
(4m) per direction.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Trees:

No Trees, Trees
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9.40. Sea

Name:
Sea
Description:
Use in combination with Urban 2x1 Straight Seaside (E) - (H)

9.41. Transition Urban 2x2 / Highway 2x2

Name:
Transition Urban 2x2 / Highway 2x2
Description:
Adapter tile with straight road connecting an urban road with two lanes (4m) in each
direction with a two-lane highway road.
Options:
Position 1: Nothing, Village Out
Position 3: Nothing, Motorway Begin
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9.42. Transition Urban/Rural 2x1

Name:
Transition Urban/Rural 2x1
Description:
Straight road with one lane (4m) per direction connecting urban and rural area.
Options:
Position 1: Nothing, Village In
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9.43. Urban 2x1 90° Curve

Name:
Urban 2x1 90° Curve
Description:
Urban 90° curve with one lane (4m) in each direction.
Options:
Position 2: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Trees:

No Trees, Trees
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9.44. Urban 2x1 Crossroads

Name:
Urban 2x1 Crossroads
Description:
Urban 4-way intersection of roads with one lane (4m) in each direction.
Options:
Right of Way: Nothing, Signs "Dangerous Crossing", Traffic Lights, Right of Way (Road),
Right of Way (Junction), Stop
Position 1:

Nothing, Village In, Village Out

Position 2:

Nothing, Village In, Village Out

Position 3:

Nothing, Village In, Village Out

Position 4:

Nothing, Village In, Village Out

60

W ORLD E DITOR

9. AVAILABLE T ILES

9.45. Urban 2x1 Double Bend (A)

Name:
Urban 2x1 Double Bend (A)
Description:
Curved urban road with one lane (4m) per direction. Over a range of approx. 200m, the road
first bends left, then right again.
Options:
Position 4: Nothing, Village In, Speed Limit 30, Speed Limit 50
Position 10: Nothing, Village In, Speed Limit 30, Speed Limit 50
Remarks:
Use this tile to reduce the number of simultaneously visible tiles.
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9.46. Urban 2x1 Double Bend (B)

Name:
Urban 2x1 Double Bend (B)
Description:
Curved urban road with one lane (4m) per direction. Over a range of approx. 200m, the road
first bends right, then left again.
Options:
Position 4: Nothing, Village In, Speed Limit 30, Speed Limit 50
Position 14: Nothing, Village In, Speed Limit 30, Speed Limit 50
Remarks:
Use this tile to reduce the number of simultaneously visible tiles.
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9.47. Urban 2x1 Double Bend (C)

Name:
Urban 2x1 Double Bend (C)
Description:
Curved urban road with one lane (4m) per direction. Over a range of approx. 400m, the road
first bends left, then right again.
Options:
Position 4: Nothing, Village In, Speed Limit 30, Speed Limit 50
Position 18: Nothing, Village In, Speed Limit 30, Speed Limit 50
Remarks:
Use this tile to reduce the number of simultaneously visible tiles.
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9.48. Urban 2x1 Double Bend (D)

Name:
Urban 2x1 Double Bend (D)
Description:
Curved urban road with one lane (4m) per direction. Over a range of approx. 400m, the road
first bends right, then left again.
Options:
Position 4: Nothing, Village In, Speed Limit 30, Speed Limit 50
Position 30: Nothing, Village In, Speed Limit 30, Speed Limit 50
Remarks:
Use this tile to reduce the number of simultaneously visible tiles.
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9.49. Urban 2x1 Straight (A)

Name:
Urban 2x1 Straight (A)
Description:
Straight urban road with one lane (4m) in each direction.
Options:
Position 1:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit
70, End Of All Prohibitions

Position 3:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit
70, End Of All Prohibitions

Finish Plate: No, Yes
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9.50. Urban 2x1 Straight (B)

Name:
Urban 2x1 Straight (B)
Description:
Straight urban road with one lane (4m) in each direction.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
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9.51. Urban 2x1 Straight Seaside (A)

Name:
Urban 2x1 Straight Seaside (A)
Description:
Straight urban road with one lane (4m) in each direction and a lake on one side which is
bordered to all sides.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions

67

9. AVAILABLE T ILES

W ORLD E DITOR

9.52. Urban 2x1 Straight Seaside (B)

Name:
Urban 2x1 Straight Seaside (B)
Description:
Straight urban road with one lane (4m) in each direction and a lake on one side which is
bordered only to the left and rear side.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Remarks:
The right side of the lake is not bordered by a wall. Use the tile Urban 2x1 Straight Seaside
(D) to have this border.
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9.53. Urban 2x1 Straight Seaside (C)

Name:
Urban 2x1 Straight Seaside (C)
Description:
Straight urban road with one lane (4m) in each direction and a lake on one side which is
bordered only to the rear side.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Remarks:
Both sides of the lake are not bordered by a wall. Use the tiles Urban 2x1 Straight Seaside
(B) and (D) to have these borders.
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9.54. Urban 2x1 Straight Seaside (D)

Name:
Urban 2x1 Straight Seaside (D)
Description:
Straight urban road with one lane (4m) in each direction and a lake on one side which is
bordered only to the right and rear side.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Remarks:
The left side of the lake is not bordered by a wall. Use the tile Urban 2x1 Straight (B) to have
this border.
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9.55. Urban 2x1 Straight Seaside (E)

Name:
Urban 2x1 Straight Seaside (E)
Description:
Straight urban road with one lane (4m) in each direction and a lake on one side which is
bordered only to the left and right sides.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Remarks:
The rear side of the lake is not bordered by a wall. Use another Seaside tile at that side to
avoid graphical errors.
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9.56. Urban 2x1 Straight Seaside (F)

Name:
Urban 2x1 Straight Seaside (F)
Description:
Straight urban road with one lane (4m) in each direction and a lake on one side which is
bordered only to the left side.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Remarks:
The right and rear side of the lake is not bordered by a wall. Use the tile Urban 2x1 Straight
(H) to have the right border. Use another Seaside tile at the rear side to avoid graphical errors.
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9.57. Urban 2x1 Straight Seaside (G)

Name:
Urban 2x1 Straight Seaside (G)
Description:
Straight urban road with one lane (4m) in each direction and a lake on one side which has no
borders at its sides.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Remarks:
All sides of the lake are not bordered by a wall. Use the tiles Urban 2x1 Straight (F) and (H)
to the left and right borders. Use another Seaside tile at the rear side to avoid graphical errors.
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9.58. Urban 2x1 Straight Seaside (H)

Name:
Urban 2x1 Straight Seaside (H)
Description:
Straight urban road with one lane (4m) in each direction and a lake on one side which is
bordered only to the right side.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Remarks:
The left and rear side of the lake is not bordered by a wall. Use the tile Urban 2x1 Straight (F)
to have the left border. Use another Seaside tile at the rear side to avoid graphical errors.
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9.59. Urban 2x1 Straight with Bridge

Name:
Urban 2x1 Straight with Bridge
Description:
Straight urban road with one lane (4m) per direction. The road is spanned by a low bridge.
Options:
Position 1:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit
70, End Of All Prohibitions

Position 3:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit
70, End Of All Prohibitions

Finish Plate: No, Yes
Trees:

No Trees, Trees

Bridge Signs: No Warning Signs, Warning Signs
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9.60. Urban 2x1 Straight with Bus Stop

Name:
Urban 2x1 Straight with Bus Stop
Description:
Straight urban road with one lane (4m) per direction. On one side of the road, there is a bus
stop.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Start Plate: No, Yes
End Plate: No, Yes
Busstops:

Busstop, no Busstop, Busstop + Pedestrians

Remarks:
This tile can be used as a free driving start point.
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9.61. Urban 2x1 Straight with Car Park

Name:
Urban 2x1 Straight with Car Park
Description:
Straight urban road with one lane per direction. On one side of the road, there is a
multi-storey car park.
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9.62. Urban 2x1 Straight with Hoarding

Name:
Urban 2x1 Straight with Hoarding
Description:
Straight urban road with one lane (4m) per direction. To one side, sight is restricted by a
timber fence.
Options:
Position 1:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit
70, End Of All Prohibitions

Position 3:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit
70, End Of All Prohibitions

Finish Plate: No, Yes
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9.63. Urban 2x1 Straight with Parking Bay

Name:
Urban 2x1 Straight with Parking Bay
Description:
Straight urban road with one lane (4m) per direction. On one side of the road, there is a
parking bay.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Start Plate: No, Yes
End Plate: No, Yes
Remarks:
This tile can be used as a free driving start point.
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9.64. Urban 2x1 Straight with Parking Space

Name:
Urban 2x1 Straight with Parking Space
Description:
Straight urban road with one lane per direction. On one side of the road, there is a parking
space.
Options:
Parking Cars: Nothing, Parking Cars
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9.65. Urban 2x1 T-Junction

Name:
Urban 2x1 T-Junction
Description:
Urban T-junction. All roads have one lane (4m) per direction.
Options:
Right of Way: Nothing, Sign "Yield", Traffic Lights, Right of Way (Junction), Stop
Position 1:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50

Position 3:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50

Position 4:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50

Trees:

No Trees, Trees
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9.66. Urban 2x1 T-Junction with Bridge

Name:
Urban 2x1 T-Junction with Bridge
Description:
Urban T-junction. All roads have two lanes (4m) per direction. The side road is spanned by a
narrow and very low bridge.
Options:
Right of Way: Nothing, Sign "Yield", Traffic Lights, Right of Way (Junction), Stop
Trees:

No Trees, Trees

Bridge Signs: No Warning Signs, Warning Signs
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9.67. Urban 2x1 T-Junction with High Bridge and Cyclist Lane

Name:
Urban 2x1 T-Junction with High Bridge and Cyclist Lane
Description:
Urban T-junction. All roads have two lanes (4m) per direction. The side road is crossed by a
cyclist lane. Sight is hindered by bridge piers.
Options:
Right of Way:

Nothing, Sign "Yield", Traffic Lights, Right of Way (Junction), Stop

Trees:

No Trees, Trees

Special Functions: None, One Way Special
Remarks:
This tile has incomplete and/or faulty properties, which must be cared for using special
scenario code. If in doubt, don’t use it.
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9.68. Urban 2x1 T-Junction with High Bridge and Tramway

Name:
Urban 2x1 T-Junction with High Bridge and Tramway
Description:
Urban T-junction. All roads have two lanes (4m) per direction. The side road has an
unguarded tramway crossing. Sight is hindered by bridge piers.
Options:
Right of Way:

Nothing, Sign "Yield", Traffic Lights, Right of Way (Junction), Stop

Trees:

No Trees, Trees

Special Functions: None, One Way Special
Remarks:
This tile has incomplete and/or faulty properties, which must be cared for using special
scenario code. If in doubt, don’t use it.
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9.69. Urban 2x2 90° Curve

Name:
Urban 2x2 90° Curve
Description:
Urban 90° curve with two lanes (4m) in each direction.
Options:
Position 2: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
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9.70. Urban 2x2 Crossroads

Name:
Urban 2x2 Crossroads
Description:
Urban 4-way intersection of roads with two lanes (4m) in each direction.
Options:
Right of Way: Nothing, Traffic Lights
Trees:

No Trees, Trees
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9.71. Urban 2x2 Crossroads with Bus Lane

Name:
Urban 2x2 Crossroads with Bus Lane
Description:
Urban 4-way intersection of roads with two lanes (4m) in each direction. In one direction, the
road has an additional bus lane.
Options:
Right of Way:

Nothing, Traffic Lights

Trees:

No Trees, Trees

Buslane Markers: No, Yes
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9.72. Urban 2x2 Double Bend (A)

Name:
Urban 2x2 Double Bend (A)
Description:
Curved urban road with two lanes (4m) per direction. Over a range of approx. 200m, the road
first bends left, then right again.
Options:
Position 4: Nothing, Village In, Speed Limit 30, Speed Limit 50, Speed Limit 70
Position 10: Nothing, Village In, Speed Limit 30, Speed Limit 50, Speed Limit 70
Remarks:
Use this tile to reduce the number of simultaneously visible tiles.
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9.73. Urban 2x2 Double Bend (B)

Name:
Urban 2x2 Double Bend (B)
Description:
Curved urban road with two lanes (4m) per direction. Over a range of approx. 200m, the road
first bends right, then left again.
Options:
Position 4: Nothing, Village In, Speed Limit 30, Speed Limit 50, Speed Limit 70
Position 14: Nothing, Village In, Speed Limit 30, Speed Limit 50, Speed Limit 70
Remarks:
Use this tile to reduce the number of simultaneously visible tiles.
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9.74. Urban 2x2 Double Bend (C)

Name:
Urban 2x2 Double Bend (C)
Description:
Curved urban road with two lanes (4m) per direction. Over a range of approx. 400m, the road
first bends left, then right again.
Options:
Position 4: Nothing, Village In, Speed Limit 30, Speed Limit 50, Speed Limit 70
Position 18: Nothing, Village In, Speed Limit 30, Speed Limit 50, Speed Limit 70
Remarks:
Use this tile to reduce the number of simultaneously visible tiles.
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9.75. Urban 2x2 Double Bend (D)

Name:
Urban 2x2 Double Bend (D)
Description:
Curved urban road with two lanes (4m) per direction. Over a range of approx. 400m, the road
first bends right, then left again.
Options:
Position 4: Nothing, Village In, Speed Limit 30, Speed Limit 50, Speed Limit 70
Position 30: Nothing, Village In, Speed Limit 30, Speed Limit 50, Speed Limit 70
Remarks:
Use this tile to reduce the number of simultaneously visible tiles.
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9.76. Urban 2x2 Roundabout

Name:
Urban 2x2 Roundabout
Description:
An urban roundabout with four exits with two lanes (4m) in both directions. The roundabout
itself has two lanes.
Options:
Signs: No Signs, Roundabout Signs
Tree: No Tree, Tree
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9.77. Urban 2x2 Straight (A)

Name:
Urban 2x2 Straight (A)
Description:
Straight urban road with two lanes (4m) in each direction.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Trees:

No Trees, Trees
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9.78. Urban 2x2 Straight (B)

Name:
Urban 2x2 Straight (B)
Description:
Straight urban road with two lanes (4m) in each direction.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Trees:

No Trees, Trees
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9.79. Urban 2x2 Straight with Bus Lane

Name:
Urban 2x2 Straight with Bus Lane
Description:
Straight urban road with two lanes (4m) in each direction. In one direction, the road has an
additional bus lane.
Options:
Position 1:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed
Limit 70, End Of All Prohibitions

Position 3:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed
Limit 70, End Of All Prohibitions

Buslane Markers: No, Yes
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9.80. Urban 2x2 Straight with Bus Stop

Name:
Urban 2x2 Straight with Bus Stop
Description:
Straight urban road with two lanes (4m) per direction. On one side of the road, there is a bus
stop.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Trees:

No Trees, Trees

Start Plate: No, Yes
Busstops:

Busstop, no Busstop, Busstop + Pedestrians
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9.81. Urban 2x2 Straight with Parking Bays

Name:
Urban 2x2 Straight with Parking Bays
Description:
Straight urban road with two lanes (4m) in each direction. There are parking bays on both
sides of the road.
Options:
Position 1:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed
Limit 70, End Of All Prohibitions

Position 3:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed
Limit 70, End Of All Prohibitions

Informational Signs: No Signs, Parking Signs
Trees:

No Trees, Trees

Parking Cars:

No Parking Cars, Parking Cars
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9.82. Urban 2x2 Straight with construction site (A)

Name:
Urban 2x2 Straight with construction site (A)
Description:
Straight urban road with two lanes (4m) in each direction, but on one side there is a
construction site with only one lane. This lane also changes from the left to the right lane.
Options:
Additional road holes: Normal road holes, More road holes
Position 4:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50,
Speed Limit 70, End Of All Prohibitions

Position 6:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50,
Speed Limit 70, End Of All Prohibitions
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9.83. Urban 2x2 Straight with construction site (B)

Name:
Urban 2x2 Straight with construction site (B)
Description:
Straight urban road with two lanes (4m) in each direction, but on one side there is a
construction site with only one lane.
Options:
Position 4: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 6: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
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9.84. Urban 2x2 Straight with park road

Name:
Urban 2x2 Straight with park road
Description:
Straight urban road with two lanes (4m) in each direction. On one side there is a park road.
Options:
Position 4: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 6: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
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9.85. Urban 2x2 T-Junction

Name:
Urban 2x2 T-Junction
Description:
Urban T-junction. All roads have two lanes (4m) per direction.
Options:
Right of Way: Nothing, Traffic Lights
Position 1:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit
70, End Of All Prohibitions

Position 3:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit
70, End Of All Prohibitions

Position 4:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit
70, End Of All Prohibitions

Trees:

No Trees, Trees
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9.86. Urban 2x2 T-Junction with Bus Lane (Start)

Name:
Urban 2x2 T-Junction with Bus Lane (Start)
Description:
Urban T-junction. All roads have two lanes (4m) per direction. In one direction, the road
gains an additional bus lane.
Options:
Right of Way:

Nothing, Traffic Lights

Position 1:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed
Limit 70, End Of All Prohibitions

Position 3:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed
Limit 70, End Of All Prohibitions

Position 4:

Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed
Limit 70, End Of All Prohibitions

Trees:

No Trees, Trees

Buslane Markers: No, Yes
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9.87. Urban Block of Buildings

Name:
Urban Block of Buildings
Description:
Solid block of buildings for filling gaps in urban areas.
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9.88. Urban Straight Transition 2x2 / 2x1

Name:
Urban Straight Transition 2x2 / 2x1
Description:
100m straight urban road. One end has one lane (4m) per direction, the other one two lanes
(4m) per direction.
Options:
Position 1: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Position 3: Nothing, Village In, Village Out, Speed Limit 30, Speed Limit 50, Speed Limit 70,
End Of All Prohibitions
Trees:

No Trees, Trees
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